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FMI Learning Series

» Topic 1: Financial Modeling Best Practices: Ten tips to
build a world-class model

» Topic 2: Checking and Reviewing a Financial Model:
What to do when something goes wrong

» Topic 3 Scenarios and Sensitivities: Predict the future

» Topic 4: Model circularity: Master the most feared topic in
Financial Modeling

» Topic 5: Model bloat: Help your models scale (and fix
those that don't)
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Today’s Topics

» Introductions
» Modeling Best Practices
» Financial Modeling Institute

> Q&A



The Financial Modeling Institute

2 Public Rigorous test to demonstrate

exams
annually

modeling acumen and proficiency

In-person/
Virtual

Computer-
based

No multiple
choice

Three levels of certification; each
L recognized as its own designation

Proctored in
a controlled
environment *FMI*

FINANCIALMODELING

INSTITUTE
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Virtual Exams — Started Oct. 2020

= Security and exam integrity through Candidates provide their
virtual proctoring platform own.
. _ Computer (only 1 monitor
= Supervision of candidates throughout allowed)

exam

Internet connectivity

=  Unusual behaviour automatically
flagged

Webcam

MS Excel

= Onscreen activity recorded Quiet, distraction free

» 4 hours, closed book, no multiple space
choice
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Recent Feedback

“Since studying for the exam, | build my
models from scratch more often. | have

become a better financial modeler.”
Jiaming, AFM | Essen, Germany | PWC

“Registering for the AFM was an easy
decision since | knew it would compliment

my CFA designation.”
Zweli, AFM | Johannesburg, SA | Investment Analyst

f_ JJ “When | interviewed, | was told | was

= chosen because of my AFM designation.”
&‘ Alexander, AFM | Toronto, Canada | FP&A
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BEST PRACTICES
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“Financial Modeling is a
Discipline”



What 1s a Financial Model?

The integration of technical skills with business / academic skills to
create user-friendly decision-making tools

TECHNICAL BUSINESS
SKILLS SKILLS

Excel Functions Accounting
Design Finance

Logic Engineering
Presentation Statistics
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Modeling Discipline

« A good model needs to be a powerful communication tool so that it can be used
to make effective decisions

« The following are important attributes of a strong financial model:

1.

6.

2
3
4.
5

Dynamic
Flexible
Intuitive
Printable
Transparent

Transferable

 When a model achieves the criteria above, it creates tremendous credibility for
the builder and inspires confidence with the reader.

 [tis also much easier for someone to take ownership of a model that meets the
criteria above.

« The one constant for financial models is that they will change over time.
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“Simplicity is the ultimate
sophistication”

- Leonardo Da Vinci
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Modeling Basics

« Keep it simple

* NEVER HARDCODE!
— Always enter inputs as a different colour than calculations
— Never enter a formula that looks like:

=A5*.025+4.9

» Use the keyboard to increase speed

» Label everything properly (even excessively)

« Everything should be printable

« Master the basics

« Become an expert at formatting

* Practice
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Modeling Best Practices

The following are some critical modeling best practices:

1.

o oA W N

8.
9.

Plan and design a model

Ask the right questions

Keep the assumptions up front

Make data inputs blue — never hardcode data into formulas
Build a Scenarios page to avoid multiple versions

Use a manageable number of worksheets - build the financial
statements vertically

Don’t do any work on the financial statements
Do all calculations on schedules

Build very simple formulas on the schedules

10. Repeat the data, then use it in formulas
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The Planning Process

* Itis critical to properly plan and design a model before it can be built

 Whenever a model becomes an illegible error-prone mess, it is almost always
because the modeler didn’t properly devise a model plan

« To create a strong plan, follow these three steps:
1. Identify the major issues
2. ldentify all assumptions that need to be made in the model

3. Identify the required schedules and components (see next page)

» As part of the planning process, you should also be able to answer the following
guestions:

— Whatis the purpose of the model?

— Which assumptions should become scenarios?

— How much detail is required?

— Do | have enough historical detail to validate the amount of forecast detail that is required?
— What is the important output that the client wants to know?

— What metric is used to measure results?

— How many time periods should be included in the forecast? Why?

— What is the most logical order to present the data?
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Information Gathering

Gathering the right information is one of the most difficult and important
parts of the modeling process

A good model can help to define the problem and the process

Don’t assume that the information provided is the right level of detail

A good financial analyst:

— asks the right questions and determines the right level of detail required to
solve the problem

— needs to be a critical thinker and realizes that a good financial model
facilitates this

— uses the model to facilitate the organization and flow of the analysis

— keeps the key players engaged in the process through regular updates and
by soliciting feedback

« The model is a means to an end, and not an end in itself

« A model needs to be a powerful communication tool to convey all of the
information regarding a particular analysis

© 2020 The Financial Modeling Institute 16



Components of a Financial Model

« Every financial model is made up of worksheets and schedules that fall into the
following three categories

« Not all models require every worksheet or schedule listed below, and some
models will require other schedules

INPUTS AND OUTPUTS FINANCIAL STATEMENTS SCHEDULES
* Model Cover * Income Statement * Revenue Schedule
* Summary Output Values * Cash Flow Statement * Costs Schedules
* Inputs / Assumptions * Balance Sheet * CAPEX/ Depreciation
Schedule

» Sources and Uses of Capital

) * Fixed Asset Schedule
« Scenarios

o * Income Tax Schedule
+ Sensitivity Tables
* Working Capital Schedule
* Debt and Interest Schedule

+ Shareholders’ Equity
Schedule

* Valuation Schedule

« WACC Schedule
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Important Modeling Tips

The following are some important tips to adhere to when creating a
financial model:

Nou s H

@

10.
11.
12.
13.
14.
15.
16.

Use a manageable number of worksheets (5 to 10 if possible)

Keep all inputs and assumptions together, and make sure inputs are ALWAYS blue
Never enter the same input twice

The model should be flexible so that inputs and assumptions can easily be tested
If possible, put all financial statements and schedules on the same worksheet

Do not insert blank columns between years

Within each worksheet, each year MUST ALWAYS be in the same column when there are
multiple schedules beneath one another

Include the model title and worksheet title prominently on every page

Label every row — have one column that’s used just for row labels

Include the date and time, page numbers and the file path on every page

Incorporate a “live” scenario tag on every page

Never delete a cell, row or column until you have determined where it flows (Auditing)
Do not make multiple copies of the model with minor revisions — use scenarios

Think about how the model will be printed and make sure the data is in page-size units
ALWAYS review your model on paper before delivering it to your colleagues or the client
Format your model as you go - don’t wait until the very end!
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MODELING SKILLS




Custom Formatting a Cell

* Applying custom formatting to cell values is very important to ensure that a cell’s
contents are clear to the reader

— Bring the Format Cells dialogue box onto your screen (press Ctrl + 1) or:

Excel 2010 Excel 2013
» Home [H] » Format [O] » Format Cells [E] » Home [H] » Format [O] » Format Cells [E]

— On the “Number” tab, click the “Custom” option at the bottom of the list
— In the “Type” list on the right, select the number format you want to edit
— To create a new format, click in the white space under the word “Type”

— The following rules apply to creating a custom number format:

« Azero or a number sign (#) is a placeholder for a number

— a#displays only significant digits, whereas a zero in the custom format box displays insignificant zeros if a
number has fewer digits than there are zeros in the format

* You can specify up to four sections of format codes. The format codes, separated by semicolons,
define the formats for positive numbers, negative numbers, zero values, and text, in that order.

» If you would like a number to begin or end with a single character (ie. 5.6x), enter the character
before or after the number placeholder (ie. enter 0.0x)

* If you would like a number to begin or end with more than one character (ie. 25 years), enter the
text in quotation marks (ie. enter 0.0 “years”)

« To include a comma separator, enter #,### (12000 will appear as 12,000)

+ A comma at the end of the number placeholder will divide the number by 1000 (ie. 12000 will
appear as 12)
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Connecting Strings of Data

« Connecting strings of data is critically important when creating inputs or
assumptions pages, or when adding footnotes to tables

Concatenate Function

= CONCATENATE(“text1”,A1,“text2”...)

— Joins text strings and cell references into one text string
— Especially useful for assumptions pages or footnotes to tables
— This function does not extract formatting from a cell being referenced

— Formatting needs to be done manually, or by using the TEXT function
Manual: =CONCATENATE(“The tax rate used in the model is ”,E20%100,“%”)

TEXT Function: =CONCATENATE(“The dollar amount is ", TEXT(E21,“$0.00"))

Ampersand “&”

— The same functionality as the CONCATENATE function

— Connects or concatenates multiple text strings and/or cell references to
produce one continuous text string

e.g. =“The tax rate used in the model is "&E20*100&"“%”
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Creating Scenarios

 |F statements are very powerful logical formulas that are used frequently
in financial models

An |F Statement is a very powerful modeling tool
The IF Function is one of 6 logical operators
IF Statements follow an IF, THEN, ELSE, pattern
=IF(B5>10,G5,H7)
=IF(C30-C60=0,“OK”,“ERROR”)
Embedded (or Nested) IF Statements allow you to include more than one IF
statement in a single formula

Embedded IF Statements can be used to create switches for assumption
scenarios

=IF(C5=1,D6,IF(C5=2,D7,IF(C5=3,D8,D9)))
Other logical operators, such as AND and OR, can be used in conjunction

with IF Statements to create even more elaborate formulas (e.g. debt
repayment schedules)
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Creating Scenarios

« The Choose function is a simpler and cleaner way of creating scenarios than
using an IF Statement

= CHOOSE(Index_num,Valuel,Value2,...)

— The Choose function chooses a value from a list of values, based on an index number
(a switch)

— The switch must always simply be a number in a cell
— The following diagram describes the CHOOSE function

Choose Function Example

A | B [ ¢ [ o | E [ F [ & _
1

2 Switch:[ 1 | =CHOOSE(B2,D4,D5,D6)

3

4 Base Case 10%

5 Best Case 20% Blue Input Cells

6 Worst Case 30%

7

Cell D2 contains the CHOOSE function. The function is first looking at the switch cell (B2).

Since the switch cell contains a 1, the CHOOSE function is extracting the contents of cell D4,
the first argument in the CHOOSE function after the switch cell reference. If the user changes
cell B2 to a 2, cell D2 would change to 20%, the contents of cell D5.

© 2020 The Financial Modeling Institute
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Timing Flexibility
* There are three ways to build a switch into a model:

1. 1/2 Switching Mechanism
« Benefits: you can use CHOOSE or OFFSET
* You can use drop down boxes to control the switch
* The problem in an expansion is that you need lots of IF statements

2. Data Validation
* You don't see the drop down arrow unless you click on the cell
* You need lots of IF statements

3. 1/0 Switching Mechanism

« Benefit: much fewer IF statements because everything gets
multiplied by the switch

 Drawback: can't use a dropdown box and the 1/0 doesn’t mean
anything

« Custom Format as follows: [=1]"On";[=0]"Off"

© 2020 The Financial Modeling Institute 24



Running Scenarios

Incorporating Pull Down Menus

— To create a more user-friendly interface on a scenario switch, a pull down menu can be
used to control the CHOOSE function

— A pull down menu restricts the values that can be entered into the switch cell, thereby
reducing the possibility of causing an error

— Bring the Forms toolbar onto your screen by doing the following:

Excel 2010: > File [F] » Options [T] » Select the “Customize Ribbon” box
» Put a check in “Developer” Tab box > Click Developer menu up top
»Click the “Insert” button

Excel 2013: » File [F] » Options [T] » Select the “Customize Ribbon” box
» Put a check in “Developer” Tab box > Click Developer menu up top
»Click the “Insert” button

— Click on the “Combo Box (Form Control)” button and use the crosshair to draw a
combo box on your screen

— While the Combo Box is selected, right click and go to » Format » Control

+ On the “Control” tab, select the range of cells containing the names of the various scenarios in
the “Input Range” box

* On the “Control” tab, enter the switch cell in the “Cell Link” box

— Click OK, then Use your mouse to pull down the arrow and run the scenario
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Validation Tool

* One additional way to restrict what a user can enter in a cell is by using Excel’s
Data Validation Tool.

— Data validation allows the creator of the spreadsheet to determine exactly what can or
cannot be entered into a cell.

— Goto » Data)» Validation

— From here you can choose what is allowed in a cell (i.e. only whole numbers, decimals,
dates, efc.) x|

Settings | Input Message I Error Alertl

— The List option is the most common

Validation criteria

selection: pa
Wﬂ ¥ Ignore blank
* When using the List option, you need Data: ¥ In-cell dropdown
to highlight a range of cells L [
» Then when you click on the cell that I 7

contains the validation, a drop-down
arrow will appear and the user will be
able to choose the option they want.

Clear Al | OK I Cancel |

— When using Data Validation, you can also choose to prompt a user with warnings and
error messages if they attempt to enter something other than what is allowed in the cell.
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Sensitivity Analysis

Goal Seek
Excel 2010 Excel 2013
» Data [A] »What-If Analysis [W] »Goal Seek [G] » Data [A] » What-If Analysis [W] > Goal Seek [G]

— Very simple sensitivity analysis, it back solves equations
— Finds a result for a cell by changing the value of another cell

— You instruct it to set a calculated cell (say Al), to a predetermined value (say 0.55), by
changing one other cell

Data Tables
Excel 2010 Excel 2013
» Data [A] »What-If Analysis [W] »>Data Table [T] » Data [A] » What-If Analysis [W] > Data Table [T]

— Creates multiple outputs under different input assumptions

— Link the cell in the top left hand corner of your table to the output value in your model
that you would like to sensitize, then highlight the entire table

— Select the “Data Table” option from the menu

— In the “Row Input Cell” box, enter the input cell in the model that you would like to
sensitize along the horizontal variable of your data table

— In the “Column Input Cell” box, enter the input cell in the model that you would like to
sensitize along the vertical variable of your data table
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Conditional Formatting

« This function formats cells that meet pre-specified criteria

— If you have more than one rule, the first rule will take priority over the second rule, so
it's important to enter the rules in the appropriate order

— The first step is to highlight all data that you want the formatting applied to (when
highlighting a column, you must start at the top and highlight down)

Excel 2010 Excel 2013
» Home [H] > Conditional Formatting [L] » Home [H] > Conditional Formatting [L]

« There are two ways to conditionally format cells:

1. Built-In Formatting Rules — formats based on cells that contain certain text, number, or
date or time values

e For example, it is possible to “Format Cells that are GREATER THAN” 25, all values greater
than 25 will be formatted

2. Use a Formula — gives additional flexibility

e For example, enter the following formula =D2>average($D$2:$D$558), all values larger than
the average will be shaded within the range of D2:D558 (think of the = sign at the beginning of
the formula as the word “if”)

— The rule that was created will be evaluated as TRUE or FALSE within each cell in the
range

e If the rule is evaluated as TRUE, the selected formatting will be applied

e If the rule is evaluated as FALSE, the selected formatting will not be applied
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FMI OVERVIEW




FMI Mission, Vision, and Values

To promote the awareness and discipline of financial modeling globally
through world-class exams and accreditation programs.

Increased awareness and acumen of financial modeling professionals
around the world.

To seek to represent the interest of the global financial modeling community.
We deliver with integrity, excellence and encourage leadership, collaboration
and innovation among all candidates and members.

i

Independence Scale Single certification body

GMVS unique offering)

Uniform measurement Expert content Industry engagement
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How Certification Works

Each level is recognized as its own qualification

|

2 ) Difficulty increases at each new certification level

3 ) Candidates may complete as many subsequent levels as they wish
LEVEL 1 LEVEL 2 LEVEL 3
KFoundationaI level of \ KAttainabIe following \ KHighest level of
certification program successful completion of accreditation achievable
« Proficiency in building Level 1 « Expert in the end-to-end
beginner-to-intermediate * Thorough understanding of financial modeling value
financial models real-world applications of chain
- Skills in design and financial modeling - Respected thought leader,
comprehension of finance, » Demonstrated ability in mentor, and contributor to
business, accounting and advanced Excel, financial financial modeling

Excel analysis, and financial education
\ / \modeling J \ J
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Why Choose the FMI

Use a globally recognized benchmark for a
reliable assessment of financial modeling
ability

Accelerate your career in finance by
earning a globally recognized
certification in financial modeling

SKILL VALIDATION

Demonstrate advanced financial modeling
proficiency to employers and clients with
independent skills validation

RISK MITIGATION
Hire professionals who have demonstrated financial
modeling abilities at the highest standard

TALENT DEVELOPMENT
Use the FMI curriculum as a validated roadmap to
guide training and development

PERSONAL DEVELOPMENT
Invest in yourself by earning certifications that are
challenging and revered by the industry

LEADERSHIP
Be a diversity and thought leader by joining the global
network of FMI professionals

CAREER FLEXIBILITY
Obtain a globally-relevant skillset that is respected
across multiple business lines
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How iIs the FMI Different?

Established to validate financial Provided by training companies

OVERALL modeling ability through rigorous, whose primary business is to sell
hands-on testing financial modeling training
programs

Candidates are not required to purchase Candidates must purchase the
TRAINING training. Available training is delivered associated training program before they

through non-remunerated third parties can achieve the certification

Always closed-book and proctored. Usually online, sometimes proctored.
EXAMS Candidates are expected to build Often includes multiple choice questions

financial models; no multiple- choice

Level 1 pass rate is approximately 50%. Pass rates are not disclosed but are

Exams are anonymized and graded usually near 100%. Grading is usually
CERTIFICATIONS manually by two graders and later automated. Certifications are not publicly

reviewed by an independent committee. verifiable.

Certifications are publicly verifiable
(candidate directory, Basno Badge)
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Testing Centers in 32 Global Cities

Melbourne Mland
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Candidate Demographics

% Candidate Representation by Continent | % Candidates with Designations

300 45% of Candidates
hold other certifications
200
(or In- Progress)
6% CPA
(or In-Progress)
100
CFA
(or In-Progress)
0

-

Avg. Candidate Age Students Full-time Professionals
32 years 21% 70%
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FMI Community

FMI Candidat

%

_—
Advisory

Approved Training
Council m Providers
Management M Tech and Logistics

FINANCIALMODELING —

. 2

Creators
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Certification Structure

Advanced toolkit to
build a dynamic
3-statement financial
forecast model of a
company

* 4-hour exam

» Candidates provided with
a case study

* Required to build an
interactive financial model
of a company

© 2018 The Financial Modeling Institute Inc.

Expert knowledge of
various topics
(accounting, finance,
investments) in financial
forecast models

* 4-hour exam

» Candidates required to
complete a selection of
advanced modeling topics

38

Focused on application of
sophisticated financial
concepts and technical

understanding of complex

business decision-making
skills

* 4-hour exam

» Candidates required to
complete a selection of
master level modeling
topics



Exam Materials

Exam Case Exam Worksheet
Small section about a Grading tab to input name
company and student number
« Simple company 3 years of historical
All the information to build 5 financials
years of assumptions » Balance Sheet
* Revenues * Income Statement
» Cost, etc... » Cash Flow

Bottom is instructions

« Same instructions every
exam

Pre-loaded
on computer

Printed
copy
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Learning Materials

ﬁ
BODY OF
KNOWLEDGE

) ) RECOMMENDED
 Available to public READING
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Approved Training Providers

$iaaccessananric - AMT Training Cj BAYFIELD %‘;? B EST

;f\ BEA<WN db Excell .. Excellence *msg%ms*

dbrown IN FINANCIAL MODELLING .. ’I}-aining Centre

CONSULTING

TRANSFORMING EDUCATION

D
PN ) PROFESSIONAL
GOALFIX
Q v\‘“ Financial Modellers I(A P LA N MIDDLE EAST
@
@ MODEL CITIZN ¢ plumsolutions
[<]

W\ Financial \{‘ FINTEGA
Arena =

37
LMS »;5¢

THE e
FinanciaL mopeLing SYSTEMATIC MAR(l[J E E ) Vil'
| ' WORLD CUP FINANCE GROUPD Virginia Institute of Finance
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